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Introduction
The Juker is a versatile jukebox. It can play MIDI (MID) songs, wave audio (WAV) files, movie clips (AVI), 
and other formats supported by the MCI driver (e.g. FLI, ..etc.). As a jukebox, though, its main purpose is 
playing songs, so all the above formats will be referred to here as songs.

Songs can be queued to play at a sequential or random order. Songs queued can be saved in an album 
and played in later sessions. The Juker saves its settings and window location on exit to use them for the 
next session. It even saves the currently playing song, so you can pick up exactly where you left off when 
you start it again. 

Song progress is shown (and can be controlled) by a moving sound bar. Undesired songs can be 
removed from the queue and optionally deleted from disk. While a song is playing, it can be stopped or 
paused and then resumed.



The Juker is meant to be unobtrusive, it can run all the time as an icon. The animated icon provides a 
pleasant visual feedback on the play progress. Song play can be paused and resumed simply by clicking 
the right mouse button on the icon. The name of the current song is shown in the icon's caption, so it's 
always visible.

When another session of the Juker is invoked while the first is still running, it merely restores and raises 
the first one, no new session is started.

See also: Albums, Animated Icon



Compatibility
Both the 16bit and the 32bit versions of the program should run well under any Windows environment. 
The table below summarizes the program's compatibility with each Windows environment, and advises of 
the recommended version to use in each environment.

16bit Version 32bit Version Version 
Recommended

Windows 3.x yes yes (with Win32s) 16bit
Windows NT yes yes 32bit
Windows 95 yes yes 32bit
OS/2 yes yes (OS/2 3.x) 16bit

Note: to run the 32bit version under Windows 3.x, you'll need at least version 1.20 of Win32s -- prior 
versions may not work.

Running the 32bit version is recommended with 32bit operating systems (such as Windows NT and 
Windows 95) to take the best advantage of the multitasking and memory protection capabilities of these 
systems.

To uninstall the program, simply delete all files in its directory. The program is considerate in that it leaves 
no files in Windows directory (i.e. no garbage DLLs are left there; everything resides in the program's own
directory).

The volume control slider will work only if your CD-ROM drive is connected to a compatible sound card 
that has an on-board mixer. The volume slider will be initially disabled until you select the output device 
you want it to control via the Options * Controls * Volume Device menu.



Tutorial
This tutorial is intended to give you an easy head-start on using the program. While it doesn't cover 
everything, it does cover most of the essential features of the program, and it is laid out in a way that 
would make it easier to follow and absorb, since it follows the way you use the program, rather than the 
reference-like layout of the rest of this help file.

OK, let the fun begin! First, start the program. Yes, do it now, go to the Program Manager and double click
on the icon to start The Juker. When you start the program for the first time, you'll see a window with the 
title Default. OK, not interesting, huh? Never mind. Let's do something. We'll worry about albums and 
such later, let's start with the easy stuff first.

What do you want to do with a jukebox? Play songs, of course! In this case, you can play any multimedia 
file, but we'll start with songs. Let's add some songs to the jukebox. Use the menu Song * Add to Album;
a dialog box will appear, from which you can select song files. This dialog looks and behaves like the 
usual Windows file open dialog, so it should look familiar to you. Let's say you have some MIDI songs 
(even if you don't, the program comes with one). In the dialog, select the directory they're in, then select 
the ones you want to add to the jukebox. Notice that you can select multiple songs at the same time; to do
that, hold down the Control key while selecting songs, or hold down the Shift key to select a range of 
songs (can you imagine how long it would take to add a hundred or so songs if we weren't able to select 
multiple ones at the same time? Wow, half an hour maybe). Finally, click OK.

Heh, I personally don't like using that clumsy dialog! I hate it! OK, so is there an even easier way to add 
songs to the album? Oops, I meant to the queue -- let's talk about albums only later.You bet there is. Go 
to the File Manager, select the songs you want, and simply drag them to The Juker. That's it! Do it now 
(unless you hate the File Manager, some people are strange like that). You'll later learn that you can open
albums by dragging them also, but let's not talk about albums now. Anyway, if you hate using the file 
manager, you can do it the other way described above. For adding lots of files, though, say thousands or 
several hundreds at the same time, use the file manager, since Windows limits how many files can be 
added by the dialog.

Hmm, now you're back to the main window. Something is different, though. Yes, the jukebox box queue 
now lists the songs you selected, and one is playing! OK, let's first familiarize ourselves with what each 
part of the window does. First, the listbox, the jukebox queue, that is, shows all the songs currently in the 
queue. That's easy to find. Beneath that, there is a digital console, similar to that of a VCR or a CD player.
It's straight-forward to recognize what the numbers in that console mean, let's go though them anyway, 
briefly. From left to right, they are the time counter (how much of the song was played, in minutes and 
seconds), the total length of the song, the song number in the queue, and the total number of songs. 
Don't worry about the other things in the console for now.

Under that, there is a slider (scrollbar). You can advance or rewind the song by that scrollbar. Try it now, 
click to the right or left of the scrollbar thumb, the song will advance (or rewind), by 10%. Click on the 
arrows at both ends of the slider to advance or rewind by 1%, or depress the mouse on the thumb and 
drag to move anywhere in the song; you'll notice the counter changing as you drag the thumb, to indicate 
where the song will be advanced to (or rewound to; oh, it's so tiring to keep saying that, sort of like a 
he/she issue!).

Beneath the slider, you'll see a row of buttonsAs you press each button, a small hint message appears in 
the status bar to tell you what each button does. Try it, press and hold down (don't release) the mouse on 
one of the buttons, you'll see the message, then move the mouse away from the button while still holding 
it down, and finally release it when you have moved it away from the button and the button is no longer 
pressed. This way you can find out what each button does without actually invoking its command. You'll 
recognize what the buttons do, anyway, since they have the same VCR symbols everybody knows 
(unless you have been living in a cage somewhere until now, that is; we must be accurate about these 
assumptions, you see). OK, enough of the chit-chat, click on the Pause button to pause the song play, 



click on it again to resume. click on the Stop button to stop playing, click on the Play button to start 
playing the song from the beginning (you can do that even if the song is already playing). Notice what 
appears in the digital console while you're doing that; it keeps you informed of what's going on.

Under the buttons, the status bar shows the current album, let's not talk about that now, and the currently 
playing song. Note that the song currently playing need not be the one selected; you can select any song 
and perform things on it (e.g. move, remove, ..etc.), while another is playing. The status bar shows the 
song playing, not necessarily the selected song. The right-most button, Highlight Current, will always 
select the currently playing song. You can use it to go back to that song after you have moved the 
selection around.

Let's go back to the queue. If the song currently playing has finished, you'll have noticed that the one after
it started playing. Let's say you have many songs in there, and you want to play a particular one. Well, go 
to that song, and double-click on it; it will immediately start playing; or select it by the mouse, click by the 
right mouse button, and choose play; or select    it by the mouse and choose the menu Song * Play; or 
select it by the mouse and click the Play button, or ....    Ah, it's getting to be too much, but you get the 
idea, it's easy to select and play a song. Experiment with that and other things for a while, while I go get a
cup of tea.

Hi, I'm back! Did you like it so far? No? Oh you lying !$@%... Ah, what's that? You did like it? Hmm, OK, 
sorry for my indiscretion. Let's go on with the show. Once you have added a few songs, you'll want to 
control the order they play in. Let's first sort the songs alphabetically. Select the menu Album * Maintain *
Sort. Now that you have sorted them, let's move a few of them around. Use the Up and Down buttons 
near the end of the button row. Click on them to move the selected song (not necessarily the song 
playing) up or down the queue. Depress the Shift key while clicking these buttons to move the song all 
the way up or down the queue. Note that you can use the menu or accelerators to do that as well, i.e. 
move songs. As a matter of fact, if you want to move a song several places in quick succession, it is 
easiest to hold down Control-U, or Control-D, since these keys auto-repeat.

OK, you may have noticed that as the last song in the queue finishes playing, playing stops. Most people 
like to go back to the first one and play that, and so forth. To make the program do that, use the Options *
Song Play * Continuous Loop. This way songs will play indefinitely, looping to the first one when the last
one finishes playing. Now, let's say you want to listen to the songs in random order. Two ways to do that. 
You can use the menu Album * Maintain * Shuffle to shuffle the order of the songs in the queue, or you 
can use the menu Options * Song Play * Random Order, to make the next song to play always chosen 
at a random order. I won't go in details to describe the difference between these two, but it is evident that 
Random Order does not disturb the physical order of the queue, and Shuffle guarantees each song to 
play once in each loop. When Random Order is checked, Continuous Loop becomes meaningless, of 
course. Not so with Shuffle.

OK, let me now briefly explain two things before going on to some fundamental stuff. Quickly, the 
Circulate button plays the next song in the queue. Think of it as a Next Song button. Except that when 
Random Order is in effect, the next song is actually chosen at random. You'll often use this button to skip
the rest of current song when you're bored with it. But what if you actually like that song very much? Well, 
the next button, Repeat, is just for you. It plays the current song over and over until you're sick to death of
it (it can actually sense that, mind you, really). Well, actually no, but you can toggle that back anytime you 
like, though.

I think it is prudent at this time to emphasize something important: the difference between Remove and 
Delete in the Song menu (or buttons). Remove merely removes the song from the queue; from the 
album, that is. Delete does not only that, but goes further to delete the song file from disk. In other words, 
you will no longer have the file, ever. Some people think it too dangerous, but you're always prompted 
before deleting any song, unless you turn that off by unchecking the Options * Confirm on Delete menu,
so be careful. Why have a Delete button? Well, say you have just downloaded a hundred songs and 
added them to the queue. You'll soon discover that most of them are junk. Yes, it is rather sad, but it is a 
fact of life, most of the MIDI songs out there really suck, pardon the language. So instead of going to the 



file manager each time you listen to an undesirable song in order to delete it. You can simply click on the 
Delete button. It will remove the song from the album, delete the song file from disk, and go on to play the
next song. This function, Delete, is also available on the system menu, so you can invoke it while the 
program is minimized.

Hmm, now for some fun. First, a puzzle. How do use The Juker 95% of the time? Well, iconized, of 
course, while you're doing other things; other useful things, mind you, not playing DOOM. Yes. I've been 
watching you! As a matter of fact, The Juker is great to be used like that, iconized, that is. Let's see why. 
First, with the song playing, minimize the program -- make it an icon. Hmm, the first thing you'll notice is 
that you can actually tell how far into the current song playing is, simply by looking at the icon. The icon 
actually changes to reflect that, sort of like a gauge that tells the percentage of the song elapsed. Now, 
what's that I'm hearing? The phone is ringing? Hmm, better take that. But wait, you can't hear the other 
party over the phone while music is playing. Well, have no fear. Simply click on the icon by the right 
mouse button to pause playing. Click again when you're finished talking to resume song play. See how 
easy it is? You can actually do that also by clicking by the left button and choosing Pause from the system
menu, still while the program is minimized, but right-clicking is much easier and faster. Take note of the 
other menu item in the system menu, anyhow; you may want to use some of those later. You can also do 
the equivalent of Repeat, which I described above, by right-clicking on the icon while depressing the Shift
key key, and the equivalent f Mute by holding the Control key. Note that you can also do this same right-
clicking business on the normal (non-iconized) window, by right-clicking anywhere on its surface. Also try 
clicking the right mouse button while holding the Alt key, see what happens.

One final thing to note related to the iconized program. The Juker takes very little CPU time to play things;
so it is ideal for using, minimized, to play songs in the background while you're moving about your 
business doing other things. Ah, one more thing, you can drag to the icon just like you can drag to the 
normal program window.

Now, let's talk about albums. While you can actually use the program without ever worrying about 
albums, they are a fundamental feature of the program that makes The Juker truly unique, and you'll soon
wonder how you ever lived without it. Well, what's an album? Any album? Well, it is a medium that 
organizes several pieces that have a common feature and collects them together. For example, a CD 
album usually have songs from the same artist, or of a certain music type. Albums in The Juker are no 
different. You can collect multimedia files, say songs, of certain music type, era, or belonging to a certain 
artist, in a convenient medium that makes it easier to organize these songs and recall them. Let's 
experiment a little with albums.

Let's say you want to collect all you AVI movies belonging to a certain project together. Or let's say you 
want to collect all Jazz MIDI songs together. Well, first, let's create a new album. Choose the Album * 
New menu. This will create a new album. Let's save it under a suitable name. Choose Album * Save As 
and save it as Jazz.Alb. you save it in any directory you like. Now add all your Jazz music files to this 
album, as described above, either by dragging them or by using the Song * Add to Album menu. That's 
it. You now have an album devoted to Jazz music. As you add and remove songs from the album, or as 
you reorganize the album, the program automatically saves it when you exit the program or load a new 
album. The title of the album is shown on the status bar. And by now I'm sure you guessed it! You were 
using an album even before we started talking about them! How? Default was just an album, called 
Default.Alb. As a matter of fact, you can load that album right now. How? Let's see.

There are more than one way to load an album. Let's say we want to load out old friend, Default.Alb. If 
you prefer using menus and dialogs, use the menu Album * Open, and choose the album from the dialog
box. If you prefer dragging, simply drag the album to the program. The program knows that this is an 
album and not a song or other multimedia file, so it will open the album, not add it to the queue. Yet an 
easier way to open an album is to take a look at the Album * Recent Albums menu. It lists all recently-
opened albums. To open and load one, simply choose it from that menu. How easier can it get?

Before I forget, I should tell you that if you close an album, by using the Album * Close menu, the default 
one, Default.Alb (in the program's directory) is opened automatically. This one is intended for people who 



do not want to bother with albums, and just use one singe album - er - queue. You can also delete albums
by the Album * Delete menu. And one more thing, when you save an album, a backup copy is made, 
usually called *.Al~, e.g. Jazz.Al~. 

One last thing. If you don't like the font used to display the songs in the album, use the menu Options * 
Control * Set Font to change it. Some people seem to think the default one is too small.

As I said, I won't explain everything in this tutorial -- I can't, there is so much to cover. But you now must 
have a grasp of the basic elements of the program, and you can wander about and experiment with things
on your own. There are so many options under the Options menu, and they are all explained in this help 
file, so you're not on your own after all.



Albums
Albums provide a convenient way of grouping songs into various categories. For example, you might want
to put all your classic music pieces in an album, jazz in another, ..etc. Or, if different people share the 
same machine, each might have his or her own album, which can be tailored according personal taste.

An album is simply a separate song queue. Earlier versions of the Juker allowed only for a single queue, 
which can be considered as supporting only a single album. An album can hold up to a thousand songs. 
However, having that many songs may make loading such an album take a relatively lengthy amount of 
time on slow computers (especially if the Allow Duplicates option is disabled). It also defeats the propose 
of the albums (i.e. to organize related songs into logical groups).

When the program is invoked for the first time, is opens a default album. You can create a new album by 
making changes to this album (adding or removing songs from the queue) and then saving it under a 
name you like using Save As. When the program is started the next time, it automatically opens the album
of the last session (unless an album is specified on the command line, see Command Line).

Unless you want to create a new album, you normally need not worry about saving albums. They are 
saved automatically on program exit and when a new album is opened (thus closing the current one). 
Automatic saving can be disabled, however, via the Auto Save Album option.

Albums are loaded by simply dragging an dropping them into the Juker's window or icon. The program is 
smart enough to know whether the dropped file is an album or a song. You can also load an album by 
selecting it from the Most Recent Albums list in the Album menu.

If you do not want to take advantage of albums, you can forget about all the above and use the Juker with
just a single song queue. Albums will be transparent to you in this case, and you need not bother with 
them.



Animated Icon
Since the Juker is meant to be unobtrusive, it is designed to be run most of the time as an icon. When 
minimized, the essential functions of the program can be activated via the system menu or the right 
mouse button (see Mouse Actions actions), and the song play progress is visually conveyed via an 
animated icon.

The icon conveys the song progress by a monotonically increasing background color shade. The 
percentage of the song that has been played is proportional of the size of the icon's background that has 
been shaded.



Command Line
The program accepts a single album file name at the command line. If such an album is specified at the 
command line, that album is loaded on startup instead of last session's or the default album. See 
Invocation Tips for more details.



Invocation Tips
Besides the usual way to starting the Juker (i.e. from the File Manager or Program Manager and then 
dragging an album if one different than last session's is desired), here are some ideas you might want to 
use:

Highlight any album (ALB) file in the File Manager. Select Associate from the File menu. Click 
Browse, and select the Juker's program file (juker.exe). Click OK. From now on you can start the Juker 
with your favorite album by simply double clicking on that album in the File Manager. Note: This is now 
performed automatically upon program installation. You may have to restart Windows for it to take effect, 
though.

After doing the above, drag your frequently-used albums to a group in Program Manager. As you 
drop each album in the Program Manager, a new entry with the Juker's icon will be created. You can then 
start you favorite album by simply double-clicking on its icon in the Program Manager. 



Other Tips
Viewing QuickTime movies and JPEG files: If you install the Apple QuickTime MCI driver, you 

can use The Juker to play QuickTime movies. You can also use the program in this case to display a 
slideshow of JPEG files. Just drag any QuickTime movies or JPEG files and drop them into the program.

Some defective MIDI files can cause the Windows sequencer to freeze while playing those files. 
You may have noticed that when using Media Player, that program sometimes gets stuck on such files. 
The Juker is smart enough to circulate to other songs when one is stuck. You can disable this behavior, 
however, if it causes you any undesirable side effect by adding the statement CirculateIfStuck=0 to 
the [Settings] section of the program initialization file, Juker.ini.

The Juker automatically saves its settings (and the current album if Auto Save Album is enabled) 
on exit. You can force the program to do that without exiting either by invoking the Save Settings Now 
menu command or by holding down the Shift key while invoking a menu command or a keyboard 
accelerator that normally closes the application (e.g. Exit or Close menu items, or the Alt+F4 accelerator).
The latter, rather non-obvious, method is similar to that of the Program Manager.

Holding down the Shift key while dropping a song starts playing that song immediately (starts 
playing the first dropped song if multiple songs are dropped). Holding down the Shift key while selecting 
the Add to Album menu command starts playing the added song immediately (starts playing the first 
added song if multiple songs are added).



Album Menu
New
Creates a new empty album called [untitled.alb]. Use must use Save As to save it under the name you 
like to give it. You are automatically prompted to do so on loading another album or exiting the program.

Open
Opens and loads an album from disk. A dialog appears from which an album can be selected.

Save
Saves the current album to disk. If an album by the same name already exits it will be backed up before 
being overwritten. The backup has the same name as that of the album, but ends with a tilde (~) in its 
extension.

Save As
Saves the current album under a possibly different name. The user is prompted for confirmation if the an 
album by the same already exists (that album will be backed up before being overwritten). Albums must 
have the extension ALB. If the name given has no extension, the appropriate extension will be appended 
to the name

Close
Closes the current album and opens the default one. The default album is called DEFAULT.ALB and 
resides in the directory in which the program resides. Note: Since this function opens the default album, it
has no effect when the loaded album is the default one.

Delete
Closes and deletes the current album and its backup. The album and its backup are physically deleted 
from disk and are lost forever. Hence, use with caution. The user is prompted for confirmation before 
performing this function.

Maintain
Contains various album maintenance menu items, described below..

Sort
Sorts the album by song names.

Shuffle
Shuffles the album's song order randomly. Note that this is slightly different from using the Random 
Order option, since in this case every song in the album is guaranteed to play in each loop. Also, in this 
case, Continuous Loop is not implies. Use any combination of Shuffle, Continuous Loop, and 
Random Play to achieve the effect you desire.

Clear
Removes all songs from the album. Stops song play.

Remove Duplicates
Removes all duplicate songs from the album. See Allow Duplicates for more details.

Note: Invoking this menu command always saves the album prior to removing duplicate songs from it, 
regardless of the state of Auto Save Album.

Properties



Displays the album properties.

Recent Albums
A list of the ten most recently visited albums is shown. Any album in this list can be opened simply by 
selecting it from this list.

Exit
Terminates the program.



Song Menu
Add to Album
Adds songs to the album. A dialog appears from which multiple song files can be selected. An alternate 
(and easier) method of adding songs to the album is by dragging and dropping them to the Juker's 
window or icon, see Mouse Actions. Note that due to limitations imposed by Windows common dialog 
boxes, you may not be able to add a large number of songs (say more than 150) at once using the dialog 
box. If this happens, add the songs in smaller chunks. You can add as many songs you like in one chunk 
using drag and drop though.

Holding down the Shift key while selecting this command starts playing the added song immediately 
(starts playing the first added song if multiple songs are added).

Play
Plays the selected song from the beginning.

Stop
Stops song play. In contrast to Pause, a song that is stopped cannot be resumed, it starts playing from 
the beginning if Play is selected.

Pause / Resume
Pauses the currently playing song, or resumes a paused song (toggle). The current state of this toggle is 
indicated by a check mark.

Repeat
Continuously plays the currently playing song until toggled back. This button is useful if during playing, a 
particular song appeals to you and you want to listen just to it for a while. The current state of this toggle 
is indicated by a check mark.

Circulate
Plays the next song, or the next randomly-selected song if Random Order is checked.

Mute
Mutes (turns off) the audio volume.(toggle). The current state of this toggle is indicated by a check mark.

Remove
Removes the selected song from the album, Plays the next song if the selected song is the one currently 
playing. If no songs are left in the album, playing is stopped.

Delete
Deletes the selected song file from disk. Prompts the user for confirmation if Confirm on Delete is 
enabled.

Move Up / Down
Moves the selected song one position up (or down) the list in the album. Note: Holding down the Shift key
while selecting this command moves the song all the way up (or down) the list, i.e. makes that song the 
first (or last) song in the queue.

Highlight Current
Moves the selection highlight to the active (playing or paused) song. If you have selected another song, 
this command is useful to quickly return you to the active song.



Options Menu
The status of every options is saved on exit and used in the next session, so there is no need to adjust it 
on every program invocation. The current state of each option is indicated by a check mark.

Continuous Loop
Continuous play. Loops to the first song when the last one in the queue finishes playing.

Random Order
Plays songs in random rather than sequential order. This also effectively yields continuous play. See also 
Shuffle under the Album menu.

Elapsed Time
Whether to show elapsed or remaining time in the counter. If checked, the time counter shows the time 
elapsed of the song currently active. If unchcked, the counter show the time remaining of the current 
song.

Auto Play
Starts playing songs automatically when an album is loaded. Otherwise song play has to be started 
manually after loading an album. The same applies when songs are added to an empty album.

MIDI Auto Reset
Some MIDI songs leave the synthesizer in an unbalanced state after they finish playing (e.g. the volume 
of some channels is left at something other than the default, ..etc.). With this option, the program resets 
the MIDI synthesizer before playing any MIDI file. This option does not affect other multimedia files such 
as WAV and AVI files in any way. This is a useful option to leave on, and is a unique feature of the Juker.

Three levels of reset are available. Standard reset turns off all notes, lifts the sustain pedal, and resets 
the controller for each channel. Full reset also sets the modulation to zero and the pitch wheel to center. 
Custom reset plays a MIDI reset file, usually supplied by the manufacturer of the synthesizer. The reset 
file must be called RESET.MID and must reside in same directory the program resides in.

Auto Save Album
Saves the current album on program exit or when another album is opened (e.g. by dragging it to the 
Juker's window or icon).

Save as Relative Paths
Saves song names relative to the album path rather than as absolute paths. Example: if the album is c:\
fun\sounds\albums\classic.alb and a song's absolute file name is c:\fun\sounds\midi\schubert.mid, the 
song will be saved in the album as ..\midi\schubert.mid if this option is enabled. 

This is useful when you want the album to be independent of the absolute path, like when you want to 
distribute and album with it songs. Example: in the above example, you can give the album and its songs 
to a friend and he/she can make the album reside as d:\music\albums\classic.alb and the song as d:\
music\midi\schubert.mid and things will work without changing anything in the album.

Note: Queue display always shows absolute paths, regardless of how the song file name is saved in the 
album. Note also that a relative path is the same as an absolue path if the album and song reside in 
dirfferent drives, so this option is immaterial in such cases.

Allow Duplicates
If unchecked, songs that are already in the album will not be added again upon dropping them into the 
application or opening the album. Otherwise, duplicate songs will be allowed in the album. Uncheck this 



option if you want to make sure no duplicates are allowed in the queue. Note though that this setting is 
not retroactive, i.e. If you already have duplicates in the album, they will no be removed when this box is 
unchecked until you reopen the album.

Note: For large albums and slow machines, disabling (unchecking) this option slows album loading 
considerably. It is recommended in such cases that you leave it enabled and use Remove Duplicates 
when you have reason to suspect there might be duplicate songs in the album, or to disable it only 
temporarily when you are adding songs you suspect are already in the album.

Confirm on Delete
Prompts for confirmation for deleting disk file when Delete is invoked.

Window Elements
These options let you show or hide some elements of the window. These include the menu, buttons, and
status bar, among others. You can also get this as a popup menu by clicking the right mouse button 
(RMB) while holding down the Control key. Always on Top makes the window always visible and on top 
of all other windows on your desktop.

One thing to note is that if you choose to hide the menu, you can have is displayed again by choosing 
Restore Menu from the system menu, by pressing Control+M, by double-clicking on the digital console 
with the left mouse button, or by bringing the popup Window Elements menu described above.

Size and Views
You can size the window to increase its width and hence see more of the song titles (in case you have 
long song titles). Default Size restores the window to its default width. The rest of this menu controls the 
different views of the window. As you show or hide different window elements using the Window 
Elements menu, you can have different views of the window. Some predefined views are listed in this 
menu, you can use them as a short -cut instead of    toggling the elements individually.

A custom view can also be defined using the Save as Custom View command. This menu command 
saves the current view as the custom one, and you can restore that view any time by the Custom View 
menu option. Hence, you can customize how you want the window to look as you please. Tip: keyboard 
accelerators are defined for these commands, in case you need to use them while the main menu is 
hidden; for example, if you want the custom view not to have the main menu.

Controls
This menu groups a few control options together like the queue font and volume device, these follow 
below.

Mini-Help
If enabled, a short message describing the highlighted menu item or the selected button is shown in the 
status bar while that menu item is highlighted or the button is pressed. Hence, all buttons and menu items
are self-explanatory. This option may be turned off once the user masters the functions of the various 
menus and buttons.

Set Font
Sets the font of the album queue list. A dialog appears from which a font can be selected.

Volume Device
Brings a dialog box to select the output device that controls volume. The Volume Slider will be initially 
disabled until a suitable device is selected using the menu.

Save Settings on Exit
Saves program settings (as well as the current album if Auto Save Album is enabled) on exit. It is highly 



recommended that you leave this option enabled all the time.

Save Settings Now
This is not option, it is a command. It saves program settings (as well as the current album if Auto Save 
Album is enabled) when invoked. You normally do not need to invoke this menu command if Save 
Settings on Exit is enabled.



Self-explanatory.



System Menu
Pause / Resume
Equivalent to Pause/Resume in the Song menu. The current state of this toggle is indicated by a check 
mark.

Repeat
Equivalent to Repeat in the Song menu. The current state of this toggle is indicated by a check mark.

Circulate
Equivalent to Circulate in the Song menu.

Remove
Equivalent to Remove in the Song menu.

Delete
Equivalent to Delete in the Song menu.

Restore Menu
This command restores the main menu and makes it appear again, if hidden. This menu item appears 
only if you have chosen not to display the main menu, via the Window Elements option.



Buttons
The program uses smart buttons. A short message describing the selected button is shown in the title bar 
while the button is held down.

 Play
Equivalent to Play in the Song menu.

 Pause / Resume
Equivalent to Pause/Resume in the Song menu.

 Stop
Equivalent to Stop in the Song menu.

 Circulate
Equivalent to Circulate in the Song menu.

 Repeat
Equivalent to Repeat in the Song menu.

 Add
Equivalent to Add in the Song menu.

 Remove
Equivalent to Remove in the Song menu.

 Delete
Equivalent to Delete in the Song menu.

 Mute
Equivalent to Mute in the Song menu.

 Rewind / Fast Forward
Rewinds the song or advances it forward. Press and hold these buttons until the song reaches the 
desired position.

 Up/Down
Equivalent to Up/Down in the Song menu.

 Current
Equivalent to Highlight Current in the Song menu.



Mouse Actions
Drag and Drop
Dragging a song (MIDI or WAV) file to the Juker's window or icon adds that song to the album queue. If 
the song is already in the album and Allow Duplicates is unchecked, the song will not be added. Dragging
an album (ALB) file closes the currently opened album and opens the dropped album.

Note, however, that although it is perfectly fine to drop multiple songs into the queue simultaneously, you 
may not drop multiple albums, nor albums and songs together.

Holding down the Shift key while dropping a song starts playing that song immediately (starts playing the 
first dropped song if multiple songs are dropped).

Left Button
Clicking the left mouse button on any song in the album selects it. While a song is selected, song 
commands (e.g. Play, Edit, and Remove) apply to it. A song may be selected even though another song 
is playing. Merely clicking the left button only selects the song, it does not play it. Double-clicking the left 
mouse button on a song selects the song and starts playing that song from its beginning.

Double-clicking the left button anywhere on the Digital Console toggles the display of the main menu on 
and off

Right Button
Clicking the right mouse button on the programs icon or window surface (not on the buttons or the list 
box) is equivalent to selecting Pause/Resume from the Song menu. Holding down the Shift key while 
doing that is equivalent to selecting Repeat. With the Control key, it's equivalent to Mute. With the Alt 
key, the Window Elements menu is displayed.

Clicking the right button on any song in the list box selects that song and pops up a menu that has a 
subset of the commands in the Song Menu. You can return to the song currently playing by choosing 
Highlight Current from the menu or pressing Control+H.



Keyboard Actions
Tab
Switches between window groups and group members.

Arrow Keys
Switches between group members. For example, when in the queue list box group, switches between 
songs; when in the Play button group, switches between the three member buttons (Play/Stop, 
Pause/Resume, Stick/Unstick, and Circulate).

Accelerators
There are also keyboard accelerators for the more frequently-used menu commands (e.g. F1 for Help 
Contents, ..etc.). These are shown on their corresponding menu items. Moreover, when the album list box
has the focus (you change the focus to it either by clicking anywhere inside it, or by pressing Tab a few 
times to switch to it), the selection highlight can be moved quickly to any song by pressing the first 
character in its name. Pressing more than once moves the selection highlight to the next song that begins
with that letter.

Keyboard Modifiers
Some mouse actions, keyboard accelerators, and menu commands perform different functions depending
on the state of the Control or Shift keys. These are mentioned in the appropriate section for each. Here is 
a sample:

Action Modifier New Effect
Drag and Drop Shift Plays the dropped song immediately
Add to Album Shift Plays the added song immediately
Up/Down Shift Moves the song all the way up (or down) the 

queue, instead of just one position
Right Mouse 
Button

Shift Equivalent to selecting Repeat

Right Mouse 
Button

Control Equivalent to selecting Mute

Right Mouse 
Button

Alt Equivalent to selecting Window Elements

Exit, Close Shift Equivalent to selecting Save Settings Now
Alt+F4 Shift Equivalent to selecting Save Settings Now

Track Bar and Volume Slider
The track bar shows the current position in the song being played. This position can be changed by 
dragging the slider of the track bar. While dragging the slider, the destination position is shown (in 
seconds) in the status bar. The song can also be advanced or receded 1% by the end arrows, or 10% by 
clicking in the area between them. The keyboard can also be used.

The volume slider controls the audio volume output. See the Compatibility section for details on when this
slider is active.



Digital Console
The digital console displays important information about the song play progress, album characteristics, 
and selected options. 

The LCD digits display the following, respectively:
· Current time position in the song.
· Length of the song in minutes.
· Song number.
· Total number of songs in the album.

The buttom row indicates whether the following is true, respectively:
· Song is playing.
· Song is paused.
· Repeat is active.
· Mute is active.
· Continuous Loop is active.
· Random Order is active.



Status Bar
In addition to displaying the current album and song titles, a short hint message describing the highlighted
menu item or the selected button is shown in the status bar while that menu item is highlighted or the 
mouse is over that button. Hence, all buttons and menu items are self-explanatory. This behavior can be 
turned off using Mini-Help from the Options menu.

Moreover, during time-consuming operations (e.g. loading or saving an album, loading a song, ..etc.), a 
brief message describing the current task being performed is displayed in the status bar.



Nothing special to note here. Have fun with the program.



Registration
This software is provided as shareware. If you use this program on a regular basis (say for more than two 
weeks), you are requested to register it. The registration fee is not much, about what you would pay for a 
decent meal in a respectable restaurant (no, McDonald's does not qualify :-). Basically, the registration fee
is:

$10 for the 16bit version of this program, or
$15 for both the 16bit and 32bit versions of this program, or
$20 for the 16bit and 32bit versions of both this program and A-B-CD (4 programs in all).

You can use whatever method of payment you like. Inside the US, probably the easiest way for you is via 
a personal check or money order. Outside the US, you can just send cash. Wrap the cash in a piece of 
paper or use a thick envelope, so that it won't be stolen. You don't have to use US dollars, use whatever 
its equivalent of your currency -- Ill just keep it as a collectible.

You can also obtain a site license of the program for a low fee. And you can obtain a license to bundle the
program with your hardware or software product, also for a low fee. Contact me for the details on those.

Make the registration fee payable to M. M. S., and send it to this address:

M. M. S. 
262 Sidney St. Apt. #3
Cambridge, MA 02139
U.S.A.

email: alsaggaf@gnu.ai.mit.edu

Please include your email address with your registration, if you have one. It makes it easy for me you 
respond to you more quickly. If you have access to ftp, The latest version of the program should be 
available by ftp at ftp.cica.indiana.edu.

And here is a printable registration form.



A-B-CD is a super CD player and database for Windows. Great for listening to CDs in the background, 
since it is quite unobtrusive and consumes virtually no CPU time. If you enter the CD and song titles, they 
are automatically remembered each time you use that CD again. You can even rearrange song order or 
remove unwanted songs from the album. Has more options that you can think of, yet it is really easy to 
use. Uses an interface similar to this program. Should be available at the same site you got this program 
from, as abcd30.zip.



Registration Form
To print this form, choose Print from the menu.

Remember, You can use whatever method of payment you like. Inside the US, probably the easiest way 
for you is via a personal check or money order. Outside the US, you can just send cash. Wrap the cash in
a piece of paper or use a thick envelope, so that it won't be stolen. You don't have to use US dollars, use 
whatever its equivalent of your currency -- Ill just keep it as a collectible.

Make the registration fee payable to M. M. S., and send it to this address:

M. M. S. 
262 Sidney St. Apt. #3
Cambridge, MA 02139
U.S.A.

email: alsaggaf@gnu.ai.mit.edu

v.60

Check one, then fill-in the rest of the information:

[ ] The Juker, 16bit version                          $10
[ ] The Juker, 16bit and 32bit versions               $15
[ ] The Juker and A-B-CD, 16bit and 32bit versions    $20

            Name: _______________________Date:___________
  Street Address: _______________________________________
City, State, Zip: _______________________________________
         Country: _______________________________________
E-mail address: _________________________________________
How did you hear about the program? _____________________
Comments:



Shareware distribution gives users a chance to try software before buying it. If you try a    Shareware 
program and continue using it, you are expected to register. Individual programs differ on details -- some 
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below. Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author 
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group. For example, some authors require written permission before a commercial disk vendor may copy 
their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your needs 
easier, because you can try before you buy, and because the overhead is low, prices are low also.    
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it.



License Agreement
This software is provided as shareware. You are encouraged to use this program on an evaluation basis 
and pass it along to friends and upload it to bulletin board systems. This program may not, however,    be 
disassembled, decomposed, reverse engineered, or altered in any way, nor any of the other files in the 
package. This includes, but is not limited to, modifying any icons, menus, or displays associated with the 
software.

This software may not be sold. This restriction, however, does not apply to connect time charges, 
download fees, or reproduction charges. This software may not be bundled with any commercial package 
without the explicit written permission of the author.

The author of this program disclaims all warranties with regard to this software, including all implied 
warranties of merchantability and fitness. In no event shall the author be liable for any special, indirect, or 
consequential damages or any damages whatsoever resulting from loss of use, data, or profits, whether 
in an action of contract, negligence, or other tortuous action, arising out of or in connection with the use or
performance of this software.

The MIDI songs included with the program are not part of it and are not covered by this license. They are 
of unknown copyright and may be distributed at will.



Revision History
Version 6.0
Version 5.7
Version 5.0
Version 4.4
Version 4.2
Version 4.0
Version 3.0
Version 2.6
Version 2.5
Version 2.3
Version 2.1
Version 2.0
Version 1.4
Version 1.2
Version 1.1
Version 1.0b



Version 6.0
Work-around for slider change position, used to skip to the next song instead of seeking into the 

current one in Windows 95 Preview.
Fixed a bug that would cause the window to have the wrong size when restored from iconic state 

in Windows 95 Preview.
Cleaned up the resize tracking (min-max) code.
When the selected mixer is outside range of valid auxiliary devices, now no mixer device is 

chosen and the volume slider is disabled.
Added a printable registration form.
Corrected the e-mail address.



Version 5.7
Fixed a bug that would cause the window elements states not to be saved correctly if the main 

menu is hidden.
Fixed the way the window behaves when resized. Now it behaves correctly even if tiled by the 

task manager.
Window elements visibility states are now saved between sessions.
All window elements are now toggelable.
The window is now sizable.
New Default Size menu command,    to restore the window to its default size.
New Views menu, speed-toggles between different window views
New Always on Top menu command.
New Custom View menu command to an option to save the custom view.
New Mute button and menu command, and can also be activated by clicking the tight mouse 

button while holding down the control key.
Added a popup menu displayed with ALT+RMB (right mouse button) that controls the different 

window elements.
Added Fast Reverse and Fast Forward buttons.
Fixed bug that would eat resources if the program is terminated while the menu is hidden. 
Main menu is now toggelable with double-click on the digital console.
Added volume control slider.
Moved Song Move buttons to the volume bar.
Mini-Help now displays fly-over hints -- no more need to press a button to see its hint.
Fixed a bug that would cause the window to be positioned slightly below its previous position 

(saved from last session) if the main menu is hidden.
Changed volume control drastically to handle all devices, and its setup is now handled via the 

Options menu.
Reorganized the Options menu slightly.



Version 5.0
Added Custom MIDI Reset, to reset the synthesizer with a custom MIDI file.
Cleaned the New Album procedure considerably. Now all new albums are called Untitled.alb, and 

the user is prompted for a new name via Save As before closing a new album.
Cleaned Save As considerably. Now prompts for invalid names and file overwrites while still in the

common dialog. Much better than before. 
Fixed the assert album name bug.
Right-clicking on slider or buttons now also performs Pause or Repeat, not just on the dialog 

surface.
New 32 bit version for Windows NT and Windows 95 (a.k.a. Chicago).
Fixed a bug that caused incorrect album name to be displayed when the album is opened by 

dropping it into the program.
Setup now associates ALB files with the program.
Fixed a bug that happened if Cancel is selected when a new album is to be saved.
Fixed a problem that would cause the first part of a MIDI song not to play correctly on the GUS.
The program now plays QuickTime movies and JPEG files correctly with the QuickTime driver.
Song information is no longer displayed on opening albums, faster ths way.
Better and faster treatment of stuck songs.
New: Shuffle Album (different than Random Play) -- shuffles the album songs once.
The program now is more courteous to other applications while performing time-consuming tasks,

although opening albums would now take slightly more real time.
The song counter is now incremented while loading the album, to give visual feedback.
Many pieces of information are displayed in the new status bar.
New, cooler buttons that reflect the Pause, ..etc. status (e.g. depressed means paused).
New Maintain Album menu. Gathers other relevant menu items under it.
The buttons and the status bar can be removed, and the location of the buttons can be changed.
Reorganized the Options menu into logical submenus.
The main menu can now be removed. Use the system menu to restore it.
Time counter can now show time left (decreasing) instead of time elapsed (increasing).
Dialogs are no longer centered on the main window, but offset a little bit. Look nicer this way.
Dialog fonts are now normal, not bold
New, better-looking About dialog.
Symbol and digital fonts no longer appear in the Change Font dialog.
Added a very informative tutorial to the help file -- a must-read. Also a tutorial button was added 

to the help file, and menu item in the program's Help menu.
Reorganized the Revision History section of the help file.
The program window is now never placed off-screen on startup.
The slider now does not start playing a song if the song is stopped, and is disabled in this case. It 

gets enabled when song play is commenced.
Cleaned up the slider position calculation code.
Upgrade dialog is now no longer shown if an older version of the program was run after the 

current one.
The initialization file (INI) is now located in the program's own directory.
Cleaned up the profile saving routines.
Better and faster treatment of stuck songs.
Various other small changes, code cleanup, and bug fixes.



Version 4.4
Added new menu item: Close Album
Fixed memory management of user interface objects. They are no longer deleted twice.
Reorganized the song information display procedures.
The timer message handler now handles re-entrance properly.
Now uses ctl3dv2.dll instead of ctl3d.dll. Much better and setup hassles.
Main window is now inactive (disabled) during lengthy operations like saving and loading an 

album.
Now uses owner-draw list boxes to place song display fields correctly, regardless of the font 

used.
Added small bitmap in the queue list.
Now uses Shift as well as Control as keyboard modifiers. Eventually, use of Control will be 

phased out.
Added new menu item: Delete Album. Deletes an album and its backup. Use with caution.
Added new option: Save as Relative Paths. Save song names relative to the album path instead 

of using absolute path names.
Fixed a bug that would cause an album to be saved in a different (wrong) directory if its path is 

unknown.
Fixed the meaning of the default album. The default album is now unique.
Auto-Play now affects also dropped songs and the Add to Album menu option.
Added Album Properties to the Album menu, to display album information.
Improved the application icon.



Version 4.2
New Auto-Play option, to control whether song play should start automatically on program start.
Frames are now painted in a different, more robust way.
New Digital Console to show album information and song progress, replaces the status bar.
New bitmap buttons. No more text buttons.
Play and option-states (play/pause/etc.) are now shown on the digital display.
Buttons, like menu options, now show mini-help message,.
Auto Save Album is now honored even if Save Settings on Exit is disabled.
Mini Help option toggle (to disable or enable Mini-Help) is now shown on the Options menu.
Renamed Stick to Repeat.
Now the queue list does not update while loading an album.
Added a new item in the Options menu: MIDI Auto Reset -- to reset the MIDI synthesizer before 

playing each song..
Fixed a bug that would cause the slider in the track bar to move erroneously when it is 

repositioned.
Fixed a bug that would cause the program to circulate to the first song if it fails to play any song in

the queue.
Holding down Shift while choosing Move Up/Down now moves the song all the way up (or down) 

the queue.



Version 4.0
First ImposterWare release.
New animated icon (has 3D frame, and song progress is now indicated by a growing color shade 

background).
Corrected Remove Duplicates when Auto-Save Album is disabled. Was not working properly in 

that case.
Control and Shift modifiers now work properly under Windows NT.
New 3D look with a chiseled frame.
Cleaned up the code quite a bit and now uses objects more extensively.
The About box is now displayed inside the screen even if the main window lies outside it.
Fixed a bug related to freeing character aggregates that would have caused heap corruption.
The newest version (2.04) of ctl3d.dll is now included with the program.
The program now recognizes if an older incompatible ctl3d DLL is installed and loaded, and 

warns the user accordingly.
When adding songs to the album via the Add to Album menu command, the number of songs that

can be added at the same time is now much larger.
Fixd a bug that caused a confirmation box to be displayed even if Confirm On Delete is disabled.
Changed the logic of Pay/Sop. Now they are decoupled.
Changed the logic of mouse clicks in the list box. Now selecting a song does not automatically 

play it.
Mini-help now shown in the window title instead of the status bar.
Some minor appearance changes (e.g. the Stick button is now flush left).
Remove Duplicates moved to album menu.
Confirm Deletions was renamed to Confirm On Delete.
Fixed a bug that might cause the wrong song to be deleted when Delete is selected.
The title bar now displays a brief message describing the current task being performed (e.g. 

loading or saving an album, ..etc.).
The program's window is now    displayed as soon as the program is invoked, not after the album 

is loaded (better feedback).
Menus and buttons are now inactive during album loading.
Fixed numerous memory leaks.
Added a new button 'Current'', equivalent to the Highlight Current menu item.
The Juker now plays AVI movie clips.
Number of saved albums changed to 9.
Album Queue has been enlarged to make more songs visible.
Moving the track bar when a song is stopped now starts playing the selected song.
Cleaned up the program's interaction with the MCI driver.
Implemented New in the Album menu, to create a new album.
Added Change Font to the Options menu -- the album queue font can now be changed.
Confirm on Delete message is now more readable.
New look with a vertical geometry. Looks and functions better.
Changed the way the program interacts with the timer (continuous use instead of frequent 

start/stop).
Many other small changes, enhancements, and bug fixes.



Version 3.0
Mini-help is implemented. A short message describing the highlighted menu item is shown on the 

status bar while the item is highlighted.
The programs's window now looks more 'composed' while loading an album or adding songs to it.
New icon for the help file when minimized.
Added ShowMiniHelp in the Settings section of the profile (but not shown on the menus).
The program now waits a bit longer (10 seconds versus 5) before circulating on songs that are 

stuck.
Added Save Settings on Exit option.
Added Save Settings Now menu command.
Pressing Shift while selecting Exit or Close, or while pressing Alt+F4 is now equivalent to Save 

Settings Now (like the Program Manager).
Holding down Control while dropping a song now starts playing that song immediately. Also true if

Shift is held down while selecting the Add Song menu item.
Added Remove Duplicates Now menu command.
Control + Right Mouse Button now toggles Stick.
Fixed a bug that prevented the program from saving its settings at the end of the Windows 

session
Fixed a bug that hindered circulating on stuck songs.
Albums are now backed up when saved.
Fixed a small bug that caused the cursor (pointer) not to be resotred properly after being changed

to the hourglass cursor.
Recent Albums menu is now handled differently (as a separate popup menu).
Added Sort album menu command.
Increased the recent album list to 10 albums instead of 5.
Fixed a bug that caused current song position display to increment by 2 seconds instead of each 

second
The user is now told if a non-existent album is selected from the Recent Albums list, instead of 

just silently ignoring the request.



Version 2.6
Fixed a bug that caused the song playing to restart from beginning if another is added to queue.
Fixed a bug that caused the song name to disappear from the window caption and status bar 

when the album is saved.
Added keyword search to the help menu.
Added keyboard accelerators for frequently-used commands.
You can now save the program's profile (settings) by pressing Shift+Alt+F4, just like the Program 

Manager.
Added CirculateIfStuck in the Settings section of the profile (but not shown on the menus).
Renamed Continue to Resume.
The icon box now looks more 3D-like.



Version 2.5
The program now uses menus. Most of the less-used functions as well as all the setup options 

have been moved to the menus.
Clicking the right mouse button on the window surface (not the buttons or the list box) now 

functions like it does on the icon (i.e. invokes Pause/Continue).
New functions: Open Album. For those who don't like opening albums by dragging and dropping 

them into the Juker's window or icon.
New functions: Add Song to Album. For those who don't like adding songs by dragging and 

dropping them into the Juker's window or icon.
Moved less frequently-used buttons to the menus.
Moved the setup area to the menus.
Removed the Most-Recent-Albums combo box and added an equivalent (and more standard) 

replacement to the Album menu.



Version 2.3
Added Up/Down buttons to move songs in the album.
Most Recent Albums now appear in an easily-accessible combo box so that they can be opened 

easily.
Changed the logic of the Play/Stop/Pause buttons to be easier.
Animated icon now behaves more correctly (smoother motion).
Album name is now displayed in the window and icon captions.
Now shows free memory and resources in the About dialog box.
Setup area now opens and closes to reduce clutter.
New setup check box: Allow Duplicates. Uncheck to prevent duplicate songs in albums.
New button layout
No longer gets stuck if a bad MIDI file is loaded (beats all other players, even Microsoft's!)
Now adds an extension to the file name in SaveAs if none is givem.
Now prompts in SaveAs if the album already exists.
Now shows an hourglass cursor when busy.
Popup error messages are now accompanied with a beep.
Tidied up the help file a bit.
The help file audio welcome message is now played correctly even if the current directory of the 

program is on another drive.
The slider of the Track Bar is now fully functional, and can be used to move back and forth in the 

song being played.



Version 2.1
Fixed a bug in Album*Save functin.



Version 2.0
Removed Size and Maximize from the system menu since they're not needed here.
Now the program itself paints the icon, instead of letting Windows do it. More flexible this way.
Added an animated icon that provides a good visual feedback of song progress.
Introduced albums. Now different song queues can be saved and retrieved at will.
Maximum number of songs saved in a queue (album) is now 1000 instead of 100.
Replaced Save Queue on Exit by Auto Save Album.
Added a survey to the archive. To be filled by interested users for feedback on the program and 

suggestions for improvement.
The program now accepts an album file name on the command line and will load it on startup if 

specified.
Beefed up the help file quite a bit. Even added a sound clip.
The program can now play WAV files as well.



Version 1.4
The program now uses a private initialization file (Juker.ini). Program information left in win.ini by 

a previous version will automatically be cleaned by the new version. Win.ini is no longer used by the 
Juker. Using a private initialization file is faster, reduces the clutter in win.ini, and is in accordance with 
Windows guidelines.

Fixed the keyboard interface, which was broken in the previous version. Also, all buttons are now 
accessible by the tab key. Much more intuitive this way.

Some appearance changes (frames around the windows).
Now saves and restores the stick state.
Added upgrade information dialog box, to alert the user to important release notes.
Fixed a bug in pause/resume that would cause the next song not to play if the current one has 

been paused then resumed.
The Juker's window no longer sizes, since it's not supposed to.
Added an informative status bar at the bottom of the window.
Added Circulate, both as a button and in the system menu.



Version 1.2
Window and icon captions are now in capitals. Easier to read when iconified.
The program now starts at the song it was playing on exit in the last session.
Clearing the queue or removing the last item now stops song play.
Added stick/unstick as a button and in the system menu.
Unified the play and pause buttons.
Full song name are now aligned as a table to make it easier to read the song name.
Cleaned up the keyboard interface (tabs and arrow keys) to make it easier to use the program 

with just the keyboard.
Now consumes virtually no CPU time.



Version 1.1
Second invocation of the program restores (if iconic) and raises first one. Does not start a new 

instance.
More object-like (check boxes, ..etc. are now implemented as objects).
Added help and activated the help button.
If Random Order is checked, the program plays a random first item when starting (if some songs 

are present in the queue).
Closing the program from the system menu now saves the profile.
Added Delete button (remove disk file) and Confirm Delete check box.
Added Remove and Delete to system menu.
New 3D look using ctl3d.dll.
Clicking the right mouse button on the icon now toggles pause/play.
Song names are shown differently in the queue so that the base name of the file is always visible,

even if the full song path name is too long. 
The program now remembers its position even if it closed while iconified.
Smaller window and fonts
Rearranged the placement of the buttons.
Now uses time as the sequence format.
Songs names are now displayed in lower case.
The sound thumbnail is now unresponsive to mouse events.



Version 1.0b
Initial release.




